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Abstract

The Graphical Object Query Language (GOQL) is a
graphical query language that complies with the ODMG
3.0 standard and runs on top of the o2 DBMS. GOQL
provides users with the User’s View (UV) and the Folders
Window (FW), which serve as the foundation upon which
end-users pose ad-hoc queries. The UV is a graphical
representation of any underlying ODMG scheme. Among
its advantages is that it hides from end-users most of the
perplexing details of the object-oriented database model,
such as methods, hierarchies and relationships. To
achieve this, the UV does not distinguish between
methods, attributes and relationships, it encapsulates is-a
hierarchies and it utilises a number of desktop metaphors
whose semantics can be easily understood by end-users.
The FW is a condensed version of the UV and provides
the starting point for constructing queries. In this paper,
we demonstrate the UV and the FW and discuss GOQL’s
system architecture, its various components and the way
these components interact to generate the UV and the FW
and to provide an ad hoc query construction mechanism.
We also present the screen interface of the language.

1. Introduction

The evolution of database languages is strongly
related partly to the evolution of user interfaces and partly
to the evolution of database models and database systems
in general. Before the early eighties not much attention
was paid to the attractiveness/popularity or user-
friendliness of wuser interfaces, mainly due to
software/hardware limitation and the type of users
expected to interact with computer systems. As
processing power increased and the use of graphics was
introduced to user interfaces, the type of the expected user
of these systems changed from that of a highly skilled one
to that of a computer literate (or naive) user. This has
happened because of technological advances that resulted
in an ever-increasing computing power that allowed
computers to ‘acquire’ skills that users used to have; an
immediate implication of this was a change in the users
training needs. Nowadays, users instead of having to deal

with the technical aspects of computer systems, need only
to learn how to complete simple work tasks, whereas the
problems they have to solve are usually expressed in non-
computing terms. Furthermore, user interfaces are being
designed according to users’ skills, because designers
believe that this is essential for improving users’
productivity [1]. A detailed survey of the evolution of
database query languages leading to the development of
Graphical Query Languages (GQLs) can be found in [2].

Our research on graphical query languages has
contributed to the subject area as follows. First of all, we
designed a new graphical scheme representation, namely
User’s View (UV), which has as basic characteristics the
use of (a) human factors, like desktop metaphors and
colour, and (b) the elimination of technical details without
loosing anything of the database model power. The
contribution of our research is that the UV is addressed to
all types of users including naive ones and also, that it is
designed to be independent of the underlying database
model. Besides that, we designed a new graphical query
language, namely GOQL (Graphical Object Query
Language), which has the same expressive power as the
ODMG 3.0 standard OQL [3] and it is the only GQL for
the ODMG 3.0 that supports also binding functions and
method parameters.

In this paper, in Section 2, we demonstrate, using an
example, the UV and the FW and the way they support
the construction of graphical queries. In Section 3, we
discuss GOQL’s system architecture, its various
components and the way these components interact to
generate the UV and the FW and to provide an ad hoc
query construction mechanism. We also address issues
related to the implementation of the GOQL system
architecture and the portability of GOQL across different
DBMS platforms. In Section 4 we present some of the
screen interfaces of GOQL to demonstrate the
implemented functionality of the system. We conclude by
discussing our current and future work. The interested
reader can find further information regarding the formal
model, the design, the use, the implementation and the
evaluation of GOQL in [2,4,5,6,7,8,9,10,11,12], whereas
a detailed discussion of the advantages GOQL offers
compared to the other graphical query languages can be
found in [2,4,7].
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2. The User’s View (UV) and the Folders
Window (FW) of GOQL

The GOQL was designed to address the needs of end-
users and to provide an alternative graphical query
language to OQL and ODBMSs that support OQL (e.g.
02). Thus, GOQL was designed to comply fully with the
features of the object model of the ODMG 3.0 [3] and its
query language, OQL. GOQL allows users to express
graphically a variety of ad hoc queries ranging from
simplistic ones to rather complicated ones. The features
provided/supported by GOQL include: the support of a
2D colour interface, the wuse/support of methods,
predicates, Boolean & set operators, arithmetic
expressions, existential /universal quantifiers, aggregate
functions, group by and sort operators, functions, and sub

queries.
To achieve these, GOQL users are presented with the
User’s View (UV), which is GOQL’s graphical

representation of an underlying ODMG database scheme
and which serves as the foundation upon which GOQL
queries are constructed. The UV allows all the features of
the underlying ODMG object model to be represented, but
it hides from users most of perplexing details, such as
methods, hierarchies and relationships. In particular, it

e does not distinguish between methods, relationships
and attributes;

e does not support the explicit representation of is-a
hierarchy lattices; instead it treats any inherited by a
subclass properties as properties of the subclass itself
and it represents them as such;

e utilises a number of desktop metaphors that allow the
representation of the other features of the object
model.

The UV is generated using the metadata of a given
ODMG database scheme and it is comprised by a number
of UV_class_tables. Each UV_class_table is a
representation of a class of the given ODMG database
scheme. It contains a representation for each of the
attributes, relationships and methods, including any
inherited ones, of the class that a particular UV_class
table represents. More specifically, the following one-to-
one mapping can be defined between constructs/features
of the ODMG data model and the graphical representation
of these constructs in the UV.

e Each class is mapped onto one UV_class_table.

e Each attribute of a class is mapped onto a property
(row) of the corresponding UV _class_table.

e Each method of a class is also mapped onto a property
(row) of the corresponding UV _class_table.

e Each relationship is mapped onto a property (row) that
is linked to a folder or a briefcase. A folder is used to
denote a class object, whereas a briefcase is used to
denote a class that has subclasses. Thus, as far as
users are concerned, there is no distinction between an
attribute, a method and a relationship.

e Each inherited attribute/relationship/method of a class
is mapped onto a property (row) of the corresponding
UV_class_table. Thus, inheritance is hidden from
users who see the properties of any superclasses as
properties of the UV_class_table itself.

e Although types are hidden from users; i.e. properties
do not display their type, the following two exceptions
have been made as it was thought that the used
denotations help users understand better the database
scheme.

o A structure type is represented by an envelope
which a user can “open” to reveal the properties
that constitute this structure type. The envelope is
placed to next to the right hand side edge a
property row.

o a collection type, i.e. a set, a bag, a list or an array,
is represented by a paper clip that is placed on the
right of the top edge inside a property row.

In Figure 1, we give the UV of the 02 ODMG
database scheme given in Appendix I. The UV shows all
UV _class_tables, their properties and their relationships
and we believe that it offers a much more simplified
representation of the database scheme compared to the
ODMG one.
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Figure 1: The User’s View for the 02 ODMG Scheme
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GOQL also provides a condensed UV, namely the
Folders Window (FW), that consists only of the class
tables represented as folders, i.e. no properties and/or
relationships are being shown, see Figure 2(a). Users can
“select” and “open” any of the folders contained in the
Folders Window to reveal its contents. By “opening” a
folder users effectively descend a level into the structure
of the ODMG class that a folder represents; to graphically
represent this, users are presented with a window that
contains the UV_class_table of any opened folders - see
Figure 2(b). Users can find more details about the
structure of a particular class by relationship browsing,
i.e. selecting and opening folders / briefcases that are
linked to rows of opened UV_class_table that represent
relationships, see Figure 2(c). Thus, using the relationship
browsing users can navigate and develop the part of the
schema required for a query.

2 !Frr.
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Figure 2: The Folders Window, Scheme Developing,
and Relationship Browsing

3. GOQL’s Architecture and Implementation

GOQL runs on the 02 Object-Oriented Database
Management System [13] and was implemented using the
02 system and Tcl/Tk [14, 15]. In particular, Tcl/Tk was
used for the implementation of the GOQL interface and
the development of the GOQL translator. Tcl is an open
source programming language that is based on the C
programming language, whereas Tk is an open source
language that provides developers of graphical user
interfaces with a library of functions/tools that accelerate
the development of graphical user interfaces. The open
source nature of Tcl/Tk and the portability of Tcl/Tk code
across platforms were the main reason that influenced our
decision towards their use. The choice of the underlying
OODBMS was determined by

(a) the support of the ODMG OQL and
(b) the availability of such DBMS.

The main reason for the ODMG OQL compliance
requirement was the portability of the GOQL system.
Thus, the 02 DBMS [13] was used as the underlying
DBMS, whereas 02C [13] was used as means of passing
the produced OQL query to the underlying OODBMS for
processing and for handling the results returned.
Although, GOQL was implemented based on the o2
DBMS, its design is such that it can be ported to another
DBMS platform that complies with the ODMG 3.0 with
minimal effort by making minimal changes to the way the
data structure is generated from the metadata of the
underlying OODBMS.

Figure 3, gives a pictorial description of the GOQL
System Architecture. GOQL consists of the Metadata
Translator, the Scheme Viewer, the Query Editor, the
Error Handling Mechanism, the Help Mechanism and the
Translator. Before any GOQL query is constructed and
run, the relevant database is loaded in GOQL. The
metadata of the underlying database schema (Appendix I)

is provided from the OODBMs to the Metadata
Translator, which constructs the database Data Structure
(Appendix II). The Data Structure consists of a number of
files that contain information about the scheme of the
underlying DBMS. These files have the same structure
regardless of the underlying OODBMs. Moreover the
class files incorporate all the is-a hierarchies and don’t
distinguish between methods and attributes.

Data Structure 4 ’
\ Translator 02

graphical|  User
query | actions

Figure 3: The Architecture of GOQL

Once the Data Structure is constructed, the Scheme
Viewer is used to generate the User’s View Window
(Figure 1) and the Folders Window (Figure 2). The
graphical representation of classes are based on the Data
Structure class files and therefore incorporate the is-a
hierarchies and do not distinguish between methods and
attributes, thus hiding from users the perplexing details of
the object-oriented database model and providing a
simplified view of the underlying database schema. The
UV and the FW provide the starting point for developing
queries. In more details, a user can start constructing,
loading, editing, deleting, running and storing graphical
queries using the Query Editor (QE). The user can load
folders from the FW in the QE and start opening them and
developing the query. During the query development, the
user can consult the UV in order to understand better the
underlying database scheme. The new query can then be
saved through the QE in the GOQL Data Structure. Saved
queries can then be opened by the QE, edited and saved.

During the query development, the Error Handling
Mechanism (EHM) checks for errors and informs the user
accordingly. More specifically, the EHM checks for
syntactical errors (incomplete or invalid graphical
queries), compatibility errors and opening file errors (e.g.
attempting to open a query before the database metadata
is loaded, attempting to open a query for another database
scheme, etc.). The Help Mechanism (HM) provides
further general and/or specific information about GOQL
and features thereof and suggests solutions for errors that
may appear. The HM is available through the UV, the FW
and the QE.

’ !Frr.
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4. GOQL’s Screen Interface

The first step, before any query is constructed in
GOQL, is to load the underlying database metadata. This
involves the use of a simple dialog box. Following the
loading of the relevant metadata, users have the option to
access the graphical scheme representation of the
underlying database either in the UV or in the FW. These
two forms are used throughout the query construction,
either in consulting way for the database structure or for
copying an object of a specific class on the Query Editor
(QE) canvas. The QE is created either by opening a stored
query or by starting a new query, by double clicking on an
object appearing in the FW. The query construction takes
place in the QEW using the available tools.

Starting the GOQL users are presented with the main
GOQL window (Figure 4). The first step is to load the
underlying database metadata. This involves a dialog
process during which users choose from a list of available
databases the one they require to use. Following their
choice, users are presented with the FW and the UV.

| Goan =1 B
e Apew  Lwin

Figure 4: The GOQL Main Window

To load the metadata users are presented with a dialog
box (Figure 5), activated by selecting the Open option
from the File pop-menu of the GOQL main window
(Figure 4). The dialog box consists of three components,
namely: the label, which displays at the top of the dialog
box the path to the current directory; the ‘UP’ button,
which users can use to move a level up in the directory
structure; and the basic environment, which is comprised
by two windows. The left window displays the names of
directories defined within the current directory; by double
clicking the left mouse on a directory name users can
descend a level in the directory structure and move to the
chosen directory. The right window displays all the o2
database files with the suffix ‘.load’. A user loads a
database by double-clicking on the database name with
the left button. Finally, a user can close a database and
any open query window by using the close menu option
of the File pop-up menu of the GOQL main window.

Following the selection of the required database users
are presented with the FW. Users can also choose to
display the UV. The FW contains all the objects of the
chosen database. Each such object is represented by a
closed folder icon (Figure 6). The FW is created either by
opening a database or by selecting the Folders option

from the View pop-up menu of the GOQL main window.
Users can ‘open’ a folder by double clicking on it. Each
‘opened’ folder from the FW can become the root object
for a subquery. Finally, whenever a user clicks the right
mouse button on an object icon the name of that object
class is displayed.

File Open =1
clioZdbaselJournal Up I

Directories Files

Jourmnal.load

P
Figure 5: Load Database Dialog Box.
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Figure 6: The FW

The UV Window (UVW) is created by selecting the
User’s View menu option from the View pop-up menu of
the GOQL main window. Users can consult the UVW at
any time during the query construction process. Figure 7
contains part of the UV of the running example.
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Figure 7: The UV Window (UVW)

The Query Editor Window (QEW) is the window where
users can construct query expressions. Users are presented
with a QEW if they select a root object from the FW or if
they choose to open an already stored query expression.
When the QEW opens, users are presented with a
horizontal toolbar, a vertical toolbar, a menu bar, a canvas
and a message line (Figure 8).

: !Frr.
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Figure 8: The Query Editor Window (QEW)

The canvas is the area where the query construction
takes place and it is where the root object that was
selected from the FW is displayed on. The message line is
used by GOQL to display explanatory messages.

All the constructs/tools/functions that GOQL offers for
the construction and manipulation of queries are
organised and made available through the menu bar and
the two toolbars. The menu bar contains five pull-down
menus, namely the Query Menu, the Edit Menu, the
Options Menu, the Tools Menu and the Help Menu.
Selecting an option from any of these menus activates the
action associated with the chosen option.

Both toolbars contain a set of buttons. Each has a
unique icon and an action/tool associated with it. Each of
the buttons corresponds to a menu option and they offer to
users a faster way of invoking a particular action/tool than
that of the pull-down menu. The icon of each button is a
metaphor for the action/tool associated with the button.
The metaphor used with each button has either been
purposely designed or been selected because it has been
commonly used in other well-established graphical user
interfaces to represent the particular action/tool associated
with this button. Selecting or ‘pressing’ a particular button
involves placing the mouse pointer over it and clicking
the left mouse button. Selecting a button activates the
associated action/tool and makes the button appear on the
user interface as being ‘pressed’. Finally, whenever the
focus of the mouse pointer is moved over a button the
background colour of this button changes to white to
highlight the event and an explanatory message about this
button is displayed on the message line.

The horizontal toolbar, Figure 9, contains sixteen
buttons, four or which (the cut button, the highlight
button, the pick button and the missing button) have been
designed for repeated use. Thus, when they are selected
they remain selected until a different button is selected.

The vertical toolbar, consists of two columns each of
which contains fifteen buttons (Figure 10). These buttons
of the vertical toolbar are organised according to their
functionality into nine groups. In particular, the aggregate

functions group comprising the ‘count’, the ‘avg’, the
‘max’, the ‘min’ and the ‘sum’ button, the Boolean
operators group comprising the ‘and’, the ‘or’, and the
‘not’ button, the comparison operators group comprising
the ‘=’, the ‘<>, the >’, the >=’, the ‘<’, the ‘<=, and
the °‘like’ button, the arithmetic operators group
comprising the ‘+’, the -’, the “*’, the ‘/°, and the ‘mod’,
the absolute operator group comprising the ‘abs’ button,
the negative operator group comprising the ‘-’ button, the
set operators group comprising the ‘union’, the ‘intersect’
and the ‘except’ button, the quantifying operators group
comprising the ‘for all’, the ‘exists’ and the ‘unique’

button and the inclusive quantifying operators group

comprising the ‘any’ and the ‘all’ button.
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Figure 9: The Horizontal Toolbar
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Figure 10: The Vertical Toolbar

The New Query button resets the query construction
mechanism in order to prepare it for a new query (the path
from the menu bar to the corresponding menu option is
Query — New). If the button is pressed while a user is in
the middle of a query construction, GOQL invokes the
save query procedure before the ‘new query’ is activated.
The starting point for a new query is always the FW
where the user has to select the root object.

The Open Query button allows users to load a stored
query expression in the QEW through the file open query

5 H'Tl"
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dialog box (Figure 11) (the path from the menu bar to the the UV and the FW interface of GOQL was also
corresponding menu option is Query — Open). presented. The various components of GOQL and the
way these components interact to generate the UV and the

. :
S - = FW and to provide an ad hoc query construction and
cieuclidigoglim/ap/oZ2dbasefthesis examples Up | . . .
evaluation mechanism were discussed. Issues related to
Directori Fil . . .
e = - the implementation of the GOQL system architecture and
13.9al the portability of GOQL across different DBMS platforms
e were also briefly discussed. Finally, GOQL’s screen
17.9a1 interface was presented. GOQL is a fully functioning
e graphical query language that is running on top of the 02
21.gal DBMS. Our current work involves continuous evaluation
- oo — and maintenance of the system, involving correction of

bugs and further enhancements of the system.

Figure 11: The Open Query Dialog Box
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APPENDIX I- The 02 ODMG Database Scheme of the Running Example of the Paper — Metadata Files
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APPENDIX II- The GOQL Data Structure Files for the Running Example of the Paper
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